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1 Introduction 

This document presents comprehensive software release information for the 
APACS+™ Control Version 6.1 components. These software products handle 
controller configuration and communications for ProcessSuite® R4 and R5 
systems and PCS 7/APACS+ OS Option Version 6.1.  

Product enhancements and other product topics are presented under the following 
headings: 

• Control Enhancements  

• Installation 

• Compatibility 

Periodically check the Siemens web site for software updates such as a 
QuickPatch, which provides the latest available software updates in a timely 
manner. Service Packs contain more comprehensive updates and are distributed 
on a CD. Service Pack details, if any, are supplied in the Appendi(x)/(ces) of this 
document. 

For additional information about individual components of APACS+ software, refer 
to the release text (release.txt) files supplied on the APACS+ Control CD, and any 
supplied Service Pack CD.  These are accessible from the Start menu as 
ProcessSuite or Siemens Release Notes. Also, complete product documentation is 
provided on the Electronic Manuals CD supplied with your system. 
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1.1 Products Involved 

1.1.1 Development Nodes 

Engineering Development 
Node 

Part Number 

Control  UPH:PS032011V61 
R4+ Full  UPH:PS042001V301a 
R4+ Keyless  UPH:PS042001KV301a 
R4+ Full Batch  UPH:PS042002V301a 
R4+ keyless Full Batch  UPH:PS042002 KV301a 
R5+ Full  UPH:PS053001V500a 
R5+ Keyless Full  UPH:PS053001KV500a 
R5+ Full Batch  UPH:PS053002V500a 
R5+ Keyless Full Batch  UPH:PS053002KV500a 

1.1.2 Archive Kits 

Archive Kit Part Number 

Control Software UPH:PS032016V61 
R4+ Software Media UPH:PS042004V301a 
R5+ Software Media UPH:PS053004V500a 

1.1.3 Desktop Nodes 

Desktop Node Part Number  

Safety Matrix  PS032043V61 

1.1.4 Client Nodes 

Client Node Part Number  

Safety Matrix PS032045V61 

1.1.5 Update Kits 

Update Kit Part Number 

V6.1 Control CD  UPH:PS032303V61U 
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APACS+ Control Components in the V6.1 release 
Component Version  

4-mation Configuration Program V4.53 
ACMx Software (new) V4.50 
ACM+ Software V4.43 
QUADLOG CCMx Software (new)  V3.53  
QUADLOG CCM+ Software V3.42 
RunTime API V4.40 
APACS+ OPC Server V1.12 
APACS+ RealTime IO Server V4.43 
Industrial Ethernet Module (IEM) FB Libraries (new) V3.52, V4.43 and V4.50 
Control Simulator/Control Engine V4.50 
Control Panel Applet V4.41 
Network Interface Manager V4.41.1.1 
Resource Init Utility V4.40 
Diagnostic Logger V4.50.0.2 
IO Import Utility V4.50 
MBUS Driver V4.50.2.1 
Sequence of Events Viewer Utility V4.40 
HLL RealTime IO Server V4.42 
LIL RealTime IO Server V4.40 
Time Synchronization Utility V4.40 
Common Libraries V4.50.1.4 
Basic Appl Library  V4.43 and V4.50 
AGA Appl Library V4.43 and V4.50 
Industrial Boiler Appl Library V4.43 and V4.50 
Hydrostatic Tank Gauging Appl Library V4.43 and V4.50 
Heat Recovery Steam Gen Appl Library V4.43 and V4.50 
Paper Stock Refiner Appl Library V4.43 and V4.50 
Batch Basic Process Cell Appl Library V4.43 and V4.50 
Advanced Regulatory Control Appl Library V4.43 and V4.50 
APACS Motorized Valve Appl Library V4.43 and V4.50 
MODBUS (Master) FB Library V4.00 and V4.50  
MODBUS (Slave) FB Library V4.00 and V4.50 
LIL FB Library V4.11 and V4.50 
Motor and Valve FB Library V4.40 and V4.50  
SOER FB Library V4.40 and V4.50  
Link Interface Module V3.03 
QUADLOG Control FB Library V3.41 and V3.53 
QUADLOG MODBUS (Master) FB Library V3.20 and V3.53 
QUADLOG MODBUS (Slave) FB Library V3.20 and V3.54 
QUADLOG SOER FB Library V3.32 and V3.53 
Failsafe Comm FB Library  V4.42 and V4.50 
QUADLOG Failsafe Comm FB Library V3.30 and V3.53 
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Component Version  

DIREKTOR FB Library  V4.40 and V4.50 
PS Batch Comm FB Library V4.40 and V4.50 
CSIM IO Sim FB Library V4.40 
CSIM IO Sim FB Library V4.40 
CSIM DIREKTOR FB Library V4.40 
CSIM PS Batch Comm FB Library V4.40 
QUADLOG CCMx Safety Matrix FB Library V3.53 
CSIM MBUS (Master) FB Library V4.40 
CSIM MBUS (Slave) FB Library V4.40 
CSIM LIL FB Library V4.40 
Profibus Fieldbus Module V4.40 
MP Universal Container V4.40 
Function Block SDK V4.40 
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2 Control Enhancements 

This section presents the major enhancements and maintenance upgrades that are 
incorporated into the APACS+ Control components. For additional information see 
the individual component release notes accessible by the Start menu after the 
control components are installed from the CD. For information on the control 
components that were not updated in this release, see APACS+ R5 Control 
Products Software Version 3.01 (SR39PS-5). 

All APACS+ control components now operate on Windows XP Professional SP2 
and Windows 2003 Server platforms, with the following exceptions: 

• APACS+ Realtime I/O Server 

• LIL Realtime I/O Server 

• HLL Realtime I/O Server 
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2.1 4-mation Configuration Software 4.53 

Enhancements 
• Operates under Windows XP and Windows 2003 Server. This is in addition to 

Windows 2000 and Windows NT 

• PCS7/APACS+ OS Option Library has been added as an application library 
which contains an "AlarmState" derived block to be copy-pasted into the 
QUADLOG® resource's "ResourceStatus".   

Maintenance Update 
• Corrects an abnormal termination when run as an automation server.  A user 

cancel action attempted to close the server. 

• It is no longer possible to move I/O channels to modules that do not support 
those channels. 

• Export to XML correctly captures Structured Text Sheets with tag referenced 
I/O. 

Operational Considerations 
• Printing an I/O Channel list for a particular I/O Module does not return a report 

if the default wild card character * is left in the "Filter on Tag Name" field.  If the 
* is deleted then the report will return data.  

• Disabled I/O Channels may have unavailable quality after an Incremental 
Transfer.  To restore the quality, each disabled I/O Channel needs to be 
enabled then disabled again. 

• It is recommended that the I/OBUSFault softlist parameter of all output 
channels be configured to HOLD_LAST_STATE prior to an Incremental 
Transfer.  The original output configuration will be restored by the transfer 
operation. 

• When using Incremental Transfer or Associated Resource to an online 
redundant controller, the A: side controller must be installed and running. 
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2.2 ACMx System Operating Software 4.50 (New) 

Operational Considerations 
• In general, the operation of this version is similar to version 4.4x of ACM/ACM+ 

software. 

• The following list of rules should be closely followed when upgrading to the 
new ACMx:  

- Do not mix ACMx modules with ACM+ as redundant partners. 

- Do not mix ACMx 4MB modules with ACMx 8MB as redundant partners.  

- Do not copy and paste logic between ACM/ACM+ and ACMx; use 
Export/Import.  

- Do not transfer configurations between ACM/ACM+ and ACMx (unless 
Export/Import database utility is completed first). 

• Export/Import of the 4-mation database must be performed before a ACM or 
ACM+ configuration can be transferred into ACMx. 

• Operational differences may be observed in some situations when comparing 
the ACMx function block results with the ACM/ACM+ function block results.  
Differences may occur in the precision of floating point calculations for real 
numbers and when "Time" datatype values are used. These differences were 
at the 6th or 7th significant decimal place. 

• The ACMx operating system software (O/S) will contain a version of the Boot-
ROM firmware.  This firmware will be checked by the O/S for compatibility 
when performing startup and future software upgrades.  The O/S will reload the 
firmware when needed. 

• The ACMx is shipped from the factory with the battery disconnected.  The 
battery must be connected to the ACMx just prior to applying power or the 
module cannot be properly initialized.  Keep the battery connected while the 
ACMx is in use.  Disconnect the battery for long term storage. 

• ACMx does not support the LIM (Link Interface Module) and the LIM 
presentation FBs have been removed. You should continue to use the ACM or 
ACM+ for the LIM and presentation FB functionality. 

Maintenance Updates from ACM+ V4.43 
• The controller will no longer incorrectly post a SSC36:EC22 error ("maximum 

number of retries for downloading configuration from the controller to an I/O 
module has been exceeded").  

• An ACMx and its redundant partner will now report their respective hardware 
revision numbers correctly to the Diagnostic Logger. Previously, the same 
revision number was displayed for both the primary and the backup, even 
when they did not match. In addition, extraneous characters will no longer be 
displayed at the end of an I/O module's hardware revision.  
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• In some blocks, an input value of 1.#QNAN ("not a number") caused 1.#QNAN 
output values. Previously, the 1.#QNAN output could remain after the 
resumption of good input values.  Now, normal output calculations will resume 
upon the return of good input values.  The affected blocks are: PID, PD, ID, 
DERIV, FILTER, LEADLAG,  SETPNT, and an AM. For SETPNT, if PV or ESP 
is 1.#QNAN, then SP, ISP, CSP, and SLIST_SP will retain their previous 
values instead of becoming 1.#QNAN.  

• An improvement was made in the storage of exception information to prevent 
BOOT ROM corruption when a CPU exception occurs.  

• The redundancy timeout has been improved to prevent the I/O scan shutdown 
when redundancy communications loss occurs.  

• The configuration crossloading between redundant partners has been 
improved to reduce the overall crossload time and reduce overscan errors.  
This also reduces Failsafe Communication (FSC) function block timeout 
susceptibility between resources.  

• The MODINFO function block will set the error mask back to zero for the 
original I/O module, when the IOBRD input is changed. 

• When redundant ACMx controllers lose redundancy synchronization and 
redundancy is no longer in operation, a SSC18:EC03 error may have been 
reported instead of SSC27:EC03.  The correct error is now reported. 
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2.3 CCMx System Operating Software 3.53 (New) 

Operational Considerations 
• During the File->Transfer->Initialize, please make sure you do not remove the 

modules or power them down.  You could render your CCMx controllers 
useless and it will require factory return to correct them.  

• This version is only compatible with QUADLOG CCMx controllers and must be 
installed to operate a new CCMx module.  In general, the operation of this 
version is similar to CCM+. 

• The following list of rules should be closely followed when upgrading to the 
new CCMx:  

- Do not mix CCMx modules with CCM+ as redundant partners 

- Do not mix CCMx 2MB modules with CCMx 6MB as redundant partners. 
(Note 17145) 

- Do not copy and paste logic between CCM+ and CCMx (Note 17004) 

- Do not transfer configurations between CCM+ and CCMx (unless 
export/import database utility is completed first) 

- Export/Import of the 4-mation™ database must be performed before a 
CCM+ configuration can be transferred into CCMx 

• Situations may occur where differences are observed when comparing the 
CCMx function block results with the CCM+ function block results.  

• Differences in the precision of floating point calculations with real and time 
values are used.  These differences were at the 7th significant decimal place. 

• When the WT_AVG function block is used for TIME datatypes, the time 
calculations may show differences between 1 to 40 ms.  

• The CCMx will sometimes handle invalid numbers (infinity values, QNAN, etc.) 
differently than the CCM+.  This may be observed when invalid numbers are 
input to a compare function block.   

• While the CCMx offers faster scan times (when compared to the CCM/CCM+), 
there are instances where some function blocks performed slightly slower.  
Examples of these blocks include the following: 

- EXP, COS, TAN, ACOS, MAT_SUB, MAT_MUL, MAT_DIV, MAT_SQRT, 
MAT_BIAS, LN, LOG, EXPT, ATAN, ASIN, PD.  

- Although these function blocks perform slightly slower, expect an overall 
scan time performance when compared to the CCM or CCM+. 

• In redundant CCMx's, Power failure during a crossover may result in loss of 
configuration.  

• After recovery from a power failure, the CCMx controller may report a software 
flow control error class 4 system service code 08 error code 02 (08:02).  
Manually clear this error and reset the shutdown logic using the RESET input 
on the shutdown logic blocks (TOTIO_SD and PARTIOSD blocks). 



Control Enhancements 

 Software Release Memo - APACS+ Control Products Software V6.1 
2-6 SR39CTRL-1 

Maintenance Updates 
• The configuration crossloading between redundant partners has been 

improved to reduce the overall crossload time and reduce scan overrun.  

• The configuration crossloading between redundant partners has been 
improved to continue MBUS communications during part of the crossload.  

• The redundancy timeout has been improved to prevent the I/O scan shutdown 
when redundancy communications loss occurs. 

• A correction was made for the proper display of the selected CCMx resource 
module.  A new 'module.cmx' will be installed and a new 'module.ini' will be 
created as part of 3.53 install. 

• An improvement in handling the redundancy messages will prevent a memory 
corruption. 

• A correction was made to eliminate a false posting of 36:22 errors posted on 
I/O downloads and configuration transfers. 

• A correction was made for the proper display of the "HW Rev" for redundant 
CCMx controllers and I/O modules as seen from the Diagnostic Logger.   

• CCMx Operating System Software V3.53 includes CCMx firmware (boot ROM) 
V3.12.  When CCMx Operating System Software is transferred to the controller 
(through 4-Mation File->Transfer->Initialize), the correct firmware is 
automatically checked and installed.  To ensure compatibility, CCMx Operating 
System Software will overwrite any pre-existing CCMx Firmware version if 
needed.  This may lengthen the CCMx initialization time. 

• Three function blocks (HLLAALM, HLLAA4, PGRMR) were changed to correct 
a "Configuration Memory Corrupt Error".  This error could occur immediately 
after restart or after several hours of operation.  The V3.53 Function Block 
Library is independent of the controller operating system. 
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2.4 CCM+ System Operating Software 3.42 

Maintenance Updates 
• The configuration crossloading between redundant partners has been 

improved to continue MBUS communications during part of the crossload.  

2.5 OPC Device Server Software 1.12 

Enhancements 
• The APACS+ OPC Device Server components have been validated for 

installation and execution on both Windows XP Pro and Windows 2003 
Standard Server, in addition to Windows 2000 and Windows NT.  For OPC 
clients connecting to the APACS+ OPC Device Server installed on either 
Windows XP Pro or Windows 2003 Standard Server, a special Software 
Firewall / DCOM configuration procedure must be followed.  This special 
configuration procedure is provided in both the OPC Device Server Software 
Guide (document number SG39OPCDS-1) and the installed OPC server help 
file. 

• The APACS+ OPC Browse DB Loader application was enhanced to support 
connecting/interacting with a SQL server installed on a PCS7 OS PC.  The first 
time the APACS+ OPC Browse DB Loader application is executed, 
immediately following an install from the Control CD, the loader cycles through 
3 different SQL server connect string sequences in order to determine the 
correct connection string for connecting to either the MSDE SQL server 
installed from the Control CD or a previously installed PCS7 OS SQL server.  
Once a successful SQL server connection attempt is made, the successful 
SQL connect string is saved in the loader application’s registry configuration for 
use on all subsequent executions. 

Maintenance Updates 
• Updated the OPC Server Enumeration application (OpcEnum.exe) and the two 

OPC Common Proxy/Stub DLLs (opccomn_ps.dll, opcproxy.dll) to the latest 
(12/02/2004) OPC Foundation Version 2.20.  This update does not fix any 
problems seen with the APACS+ OPC Device Server.  However, the OPC 
Foundation recommends that the latest versions of these common files always 
be included as part of the OPC vendor's install. 

• A maintenance update was made to the OPC server to fix a problem that 
occurred when an OPC client first connects to the server.  The OPC server 
connection problem resulted in a generic MS Windows error popup stating the 
APACSOPCDeviceServer made a "Pure Virtual Function" call.  Acknowledging 
the error dialog would result in the OPC server aborting.  This problem would 
only occur intermittently. 
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• A maintenance update was made to the APACS+ OPC Browse DB Loader 
application to correct a problem where some of the tags contained within a 
.CSV file, generated from the APACS+ Database Automation application, were 
not being loaded into the OPC browse database. 

2.6 Control Simulator 4.50 

Enhancement 
• The Control Simulator software now operates under Windows XP and 

Windows 2003 Server. This is in addition to Windows 2000 and Windows NT. 

• When the "Security On" box is checked on the faceplate of a Quadlog Control 
Simulator, the Quadlog Security Control Block (QL_SECR) now functions in 
the same manner as when the Security Enable switch on a CCM is enabled.  
The function block EN input must also be set to TRUE for security to be 
enabled and the faceplate LED to be lit. 

• ACMx and CCMx memory models were added to the control simulator. 

• Gateway function blocks (GW_SEND, GW_REC) were added to the Control 
Simulator. The blocks are not operational in the simulator, but this allows 
configuring the blocks in the simulator, before deploying the configuration in a 
real controller. 

2.7 M-BUS Driver 4.50 

Enhancement 
• The M-BUS Driver software now operates under Windows XP and Windows 

2003 Server. This is in addition to Windows 2000 and Windows NT. 
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2.8 Diagnostic Logger Software 4.50 

Enhancement 
• The Diagnostic Logger software now operates under Windows XP and 

Windows 2003 Server. This is in addition to Windows 2000 and Windows NT. 

• The Diagnostic Logger now supports the ACMx, CCMx, IDO, QUADLOG CAM, 
QUADLOG CAI, and QUADLOG CDO modules. 

Operational Consideration 

• If the detailed error information does not display when double-clicking on an 
entry, or the help file does not display when selecting it from the Help menu, 
then the Diagnostic Logger application should be restarted.  

2.9 Control Panel Applet 4.41 

Operational Consideration 

• The Advanced area of the APACS.INI page will not allow a value of 0 for the 
MBUS-RETRY_ADDR or ENET_RETRY_ADDR parameters.  If a value of 0 is 
desired for either of these parameters, it must be entered by manually editing 
the APACS.INI file in the c:\etc\ directory. 
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3 Install APACS+ Control CD V6.1 

 
 Note 

The following procedure is based on a typical installation.  

 
 Note 

The OPC Device Server needs MS SQL Server. If MS SQL Server is not installed, 
install the copy of MSDE from the Microsoft folder on this CD.  

 
 Note 

Prior to installing this software, log on with Administrator rights and disable any 
virus protection software that is currently running.  

 

2. Insert the APACS+ Control CD V6.1 into the CD ROM drive.  
The Welcome to Siemens window opens. 

 
3. Click the Next button. 

The Software License Agreement window opens. 
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4. Read the Software license agreement.   

Click the Yes button to accept the agreement. 
The Choose Installation Path dialog box opens.  
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5. Select an installation path, and click the Next button.  
The Choose Directory dialog box opens (only if you click on the browse 
button in the Choose Installation Path dialog box.)  

 
 

6. Click the OK button. 
For new installations, the Choose the License Source dialog box opens.  
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For upgrade installations, the Select Install Type dialog box opens.  
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7. Select the license file source. For new installations, the license should be on 
the diskette.  
Click the Next button. 
The APACS+ Component Selection dialog box opens. Make any changes to 
the list of components selected for installation by selecting a category, clicking 
the Change button, and selecting the components to install.  
Your choice of components depends on the type of 
station (server, client, etc…) you are installing.  

 
8. Click the Next button.  

If this is the first time OPC Server is being installed, the Select OPC Device 
Server Startup Mode dialog box opens.  
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If OPC Server has been installed before, the Select Runtime API dialog box 
opens. 
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9. Select the appropriate option for your installation. 
Click the Next button. 
The Review Selections and Installation Paths dialog box opens. 

 
10. Scroll through the list and verify that the correct components have been 

selected. If any components are missing or were incorrectly selected, click the 
Back button to return to the screen to reselect the appropriate components. 
When you are satisfied that the list is correct, click the Install button. 

The installation begins copying the files. 
The Installing Support Software progress bar opens.  

 
 Note 

If you are installing on Windows XP or Windows 2003, the installation will inform 
you that the software has not undergone Windows Logo testing. Click OK to 
acknowledge, and continue the installation. The Windows operating system will 
again warn you that the software has not undergone Windows Logo testing. Click 
the Continue Anyway button to continue the installation. Windows Logo testing 
does not affect the installation or operation of the software. 
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11. The Reboot your System? dialog box opens. 
If you had a license diskette in the floppy drive, remove it. Take the Install CD 
out of the CD drive.  
Select the Yes, I want to restart my computer now. radio button, and click 
the Finish button.  
The installation is complete.  
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4 Compatibility 

Control software products and operating platforms compatible with the APACS+  
4-mation Configuration Software version 4.53 are listed in the following tables.  
Use the current version of APACS+ software to obtain the latest features.  All 
hardware products must be compatible with the associated software products. 

Software Compatible with 4-mation Configuration Software V4.53 
Compatible Software Products Version 

Advanced Control Module (ACM) Software 4.00 - 4.50 
Advanced Regulatory Control Application Library 4.00 - 4.43 
AGA Application Library 4.30 - 4.43 
APACS+ Realtime I/O Server Software (32 bit) 4.00 - 4.43 
API (Application Program Interface) 4.00 - 4.42 
Batch Basic Process Cell Application Library 4.01 - 4.43 
Control Engine 4.40 - 4.50 
Control Simulator (includes APACS+ and QUADLOG Simulators) 4.40 - 4.50 
Control Simulator Direktor™ Communication Function Block Library 
(Requires Runtime API 4.36 or higher) 

4.40 

Control Simulator I/O Simulation Function Block Library 4.40 
Control Simulator Motor Valve Function Block Library 4.40 
Control Simulator ProcessSuite Batch Function Block Library 4.40 
Diagnostic Logger 4.40 - 4.50 
Direktor™ Communication Function Block Library 4.00 - 4.50 
Fail Safe Communications Function Block Library 4.42-4.50 
Function Block Wizard 4.40 
Heat Recovery Steam Generator Application Library 4.30 - 4.43 
Hydrostatic Tank Gauging Application Library 4.30 - 4.43 
Industrial Boiler Application Library 4.30 - 4.43 
Link Interface Module (LIM) System Software 3.03 
Local Instrument Link (LIL) Function Block Library 4.11-4.50 
MODBUS Master Function Block Library 4.00-4.50 
MODBUS Slave Function Block Library 4.00-4.50 
Motorized Valve Application Library 4.30 - 4.43 
NIM32 4.40 - 4.41 
OPC Device Server (Requires Runtime API 4.36 or higher) 1.00 - 1.12 
Paper Stock Refiner Application Library 4.30 - 4.43 
ProcessSuite Batch Communication Function Block Library 4.00 - 4.50 
QUADLOG Critical Control Module (CCM) Software 3.20 - 3.53 
QUADLOG Advanced Control Module (ACM) Software 3.03 
QUADLOG Advanced Control Module Plus (ACM+) Software 3.21 - 3.41 
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4-2 SR39CTRL-1 

Compatible Software Products Version 

QUADLOG Control Function Block Library 3.30 - 3.53 
QUADLOG Fail Safe Communications Function Block Library  3.30 - 3.53 
QUADLOG Sequence of Events Recorder Function Block Library 3.20 - 3.53 
QUADLOG MODBUS Master Function Block Library 3.03 - 3.53 
QUADLOG MODBUS Slave Function Block Library 3.03 - 3.54 
QUADLOG Safety Matrix Software 1.00 - 1.03 
QUADLOG Safety Matrix Function Block Library 3.34 - 3.53 
Satellite Control Module (SCM) System Software 4.00 
Sequence of Events Recorder Function Block Library 4.00 - 4.50 
Standard Motor and Valve Function Block Library 4.00 - 4.50 

Operating Platforms Compatible with 4-mation Configuration Software 4.53 
 
4-mation Configuration  
 
ETHERNET MODULBUS 
Windows NT Windows NT 

Windows 2000 Windows 2000 
Windows XP Windows XP 
Windows 2003 Server Windows 2003 Server 

 

Module ROMs and Other Software Compatible with 
ACM/ACM+/ACMx System Software  

ROM or Other Software Version  

Advanced Control Module (ACM 4.43) 3.03 

Advanced Control Module Plus (ACM+ 4.43) 4.00 

Advanced Control Module Ex (ACMx 4.50) 3 4.10 

APACS+ Runtime API                4.00 - 4.42 

APACS+ Realtime I/O Server  4.00 - 4.43 

Enhanced Analog Module (EAM) 3.00 - 3.01 

HART Fieldbus Module (HFM) 3.00 - 3.02 
Input Discrete Module (IDM) 3.00 
Isolated Discrete Output (IDO)2 3.00 
Kernal OpCode  (15939-783) (IDO) 1.52 
Link Interface Module (LIM) 3.00 
Network Interface Module (NIM/RNI) 3.00 - 3.09 
APACS+ NIM32  4.40 – 4.41 
Output Discrete Module (ODM) 3.00 
PROFIBUS Fieldbus Module (PFM) 3.00 - 3.03 
Kernal OpCode  (15939-810V) (PFM)  1.53 
Resistance Temperature Module (RTM) 3.00 - 3.02 
Satellite Control Module (SCM) 4.00 



 Compatibility 

Software Release Memo - APACS+ Control Products Software V6.1 
SR39CTRL-1 4-3 

ROM or Other Software Version  

Standard Analog Input Module (SAI) 2 3.00 - 3.03 
Kernal OpCode  (15939-818) (SAI) 1.54 
Standard Analog Module (SAM) 3.00 - 3.05 
Standard Discrete Module (SDM) 3.00 - 3.01 
Standard Discrete Module Plus (SDM+) 24 Volt Version 3.00 - 3.23 
Standard Discrete Module Plus (SDM+) 48 Volt Version 3.00 - 3.23 
Voltage Input Module (VIM) 3.00 - 3.02 

Notes 
1. In modules with more than one ROM, each ROM must be the same version. 

The ROM version number is listed on the module’s identification label. 

2.  May require kernal opcode for field upgrade. 

3. ACMx boot ROM code is installed by the operating system to assure correct 
version. 



Compatibility 

 Software Release Memo - APACS+ Control Products Software V6.1 
4-4 SR39CTRL-1 

Module ROMs Compatible with  
QUADLOG CCM/CCM+/CCMx Software  

ROM Software Version 

QUADLOG Critical Control Module (CCM 3.41) 3.03 
QUADLOG Critical Control Module Plus (CCM+ 3.42) 3.03 
QUADLOG Critical Control Module Ex (CCMx 3.53)4 3.12 
QUADLOG Critical Analog Input Module (CAI)3 3.00 - 3.04 
QUADLOG Kernal OpCode (15939-818) (CAI) 1.53 
QUADLOG Critical Analog Module (CAM)3 3.01 - 3.04 
QUADLOG Kernal OpCode (15939-761V) (CAM) 1.52 
QUADLOG Critical Discrete Module (CDM) 3.02 - 3.04 
QUADLOG Critical Discrete Output (CDO-DC) 3 3.00 - 3.01 
QUADLOG Kernal OpCode (15939-783V) (CDO) 1.52 
QUADLOG Enhanced Analog Module (EAM) 3.01 – 3.02 
QUADLOG Input Discrete Module (IDM) 3.00 
QUADLOG Output Discrete Module (ODM) 3.01 
QUADLOG Resistance Temperature Module (RTM) 3.00 - 3.01 
QUADLOG Standard Analog Module (SAM) 3.00 
QUADLOG Standard Discrete Module Plus (SDM+) 3.02 - 3.03 
QUADLOG Voltage Input Module (VIM) 3.01 – 3.04 

Notes 
1. In modules with more than one ROM, each ROM must be the same version. 

The ROM version number is listed on the module's identification label. 

2. For additional QUADLOG compatibility information, refer to the QUADLOG 
release.txt files on the Control CD. 

3. May require kernal opcode for field upgrade. 

4. CCMx boot ROM code is installed by operating system to assure correct 
version. 
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